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THE LEADERSHIP LEDGER 

Volume 3  Issue 8 

April 14, 2022 

The American Legion, Department of Maine   
5  Verti Drive, Winslow, Maine  04901-0727 

www.mainelegion.org | legionme@mainelegion.org | 207-873-3229 

Facebook: www.facebook.com/maineamericanlegion 

THE AMERICAN LEGION  
DEPARTMENT OF MAINE 

ANNUAL STATE CONVENTION 

June 10-11, 2022 

Jeff's Catering & Event Center 
15 Littlefield Way, Brewer, Maine 04412 

Member/Guest Registration Form & 

Elected Post Delegate/Alternate Form  

Or see pages 14 & 15 of this  
Ledger for a hard copy 

Please see the above Member/Guest Registration & 
Elected Post Delegate/Alternate Form. All elected 
delegates and alternates are to fill out the Post  
Delegate and Alternate form. If you are not a  
Delegate/Alternate, please fill out the Member/Guest 
Registration form.  This form may also be found on 
pages 12-13. 

YOUR NAME SHOULD ONLY 
APPEAR ON ONE FORM. 

THE FEE PER PERSON IS $10.  

Click here for  
Entitlement to Delegates and Alternates.   

This form is also available on Page 14. 

 For more information, please visit 
www.mainelegion.org  

or call Department HQ at 207-873-3229.  

 

DISTRICT MEETINGS 

Be Connected – Be Heard – Be Informed 

District 5 – Oxford: Apr. 20 
Rumford Post 24, light supper at 6PM,  

Installation of Officers at 7PM 

District 14 – Piscataquis: Apr. 16,  
Dexter Post 53, 12 Noon Lunch  

w/Business Meeting at 1PM 
 

W elcome to the 64th Edition of The Leadership 

Ledger. It includes Post, Department and  

National reports, leadership training events, upcom-

ing conferences/conventions as well as rules and 

regulations pertaining to local, state and national 

laws. The Ledger is available by visiting the  

Department’s website at www.mainelegion.org  

under “News & Events” or on the home page. If you 

have any information to be published in The  

Leadership Ledger, please forward to Department 

HQ via email at: legionme@mainelegion.org. 

 
 

Warrant Templates 

All Positions 

Available on-line at  

MaineLegion.org or go to:  

http://www.mainelegion.org/pages/formsapplications.php 

 
 Department Finance Officer at 

The American Legion, Department of Maine 

Click on the link above for the job description  
or visit:  

www.mainelegion.org/pages/news-events.php 

http://www.mainelegion.org
mailto:legionme@mainelegion.org
http://www.mainelegion.org/media/State_Convention/STATECONVENTION_REGISTRATION_FORMS2022_FILLABLE_4.pdf
http://www.mainelegion.org/media/State_Convention/STATECONVENTION_REGISTRATION_FORMS2022_FILLABLE_4.pdf
http://www.mainelegion.org/media/State_Convention/STATECONVENTION_REGISTRATION_FORMS2022_FILLABLE_4.pdf
http://www.mainelegion.org/media/State_Convention/STATECONVENTION_REGISTRATION_FORMS2022_FILLABLE_4.pdf
http://www.mainelegion.org/media/misc/Entitlement_To_Delegates_and_Alternates2.pdf
http://www.mainelegion.org
http://www.mainelegion.org
mailto:legionme@mainelegion.org
http://www.mainelegion.org/pages/formsapplications.php
http://www.mainelegion.org/media/misc/DEPARTMENT_FINANCE_OFFICER_01062022.pdf
http://www.mainelegion.org/media/misc/DEPARTMENT_FINANCE_OFFICER_01062022.pdf
http://www.mainelegion.org/pages/news-events.php
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PORTLAND SEA DOGS  
AMERICAN LEGION DAY 

Saturday, May 21, 2022 

     Gates: 11:30 AM, First Pitch: 1:00 PM 

Join the Sea Dogs and  
The American Legion for a Ballgame  

O n Saturday, May 21st, The Portland Sea Dogs 
are teaming up with the American Legion for a 

fun afternoon at the ballpark when the Sea Dogs take 
on the Harrisburg Senators (AA Affiliate of the 
Washington Nationals). The game is at 1:00 PM and 
the gates open at 11:30 AM. 

Purchase your game tickets by visiting https://

seadogs.formstack.com/forms/legion5_21 and you 

will receive a ticket at a special group price of $11.00 

($1.00 off the standard price). Additionally, $2.00 per 

ticket will be donated to the American  

Legion. You will also be invited onto the field pregame 

for a group photo in front of the Maine Monster.* 

*Everyone will meet in the left field grandstand  

before 12:15 PM and escorted onto the field shortly there

-after for the photo. We will have our Fan Photographer 

take the photo, which will be posted on our Face-

book page in the May 21st Game Day Photo Album. 

There is a $2.00 processing fee per order.  

For orders of 10 or more tickets, please call the 

ticket office at 207-879-9500 and ask for Alan. 

If you have any questions, please email 

Abarker@seadogs.com for more information.

 

DIRIGO STATE PROGRAM 
Thomas College, Waterville 

June 19-24, 2022 

Cost per Student is $400 

2022 Dirigo State Applications 
Now Available! 

For more information please visit: 
www.mainelegion.org  

or contact Jason Hall at 207-873-3229 
E-mail: jason@mainelegion.org 

Dirigo State Volunteers  
Needed! 

CLICK HERE For More Information 
 Or go to: 

http://www.mainelegion.org/pages/programs/dirigo-state.php 

2021-2022 

Eastern Region  
Unofficial Gathering 

Testimonial Dinner Honoring: 

Richard “Dickie” Huntley  
Sons of the American Legion,  

National Vice Commander East 

Please join us on Saturday, May 21st, 2022, 
at Smith Tobey American Legion Post 21, 200  
Congress Avenue, Bath, ME 04530 

This evening’s events will include a social hour at 
5:00pm followed by a delicious Surf and Turf  
Dinner featuring Maine Lobster or Steak at 6:00pm, 
followed by testimonial. A cash bar will be available. 

Appetizers: Steamed Clams, Meat/Cheese/Cracker Plate 

Entrée: Choice of: Steamed Maine Lobster or Steak. 
Each Entrée includes Garden Salad, Baked Potato, Corn 
on the Cob or Seasonal Mixed vegetables, and Rolls 

Dessert: Shortcake with Homemade Whipped Cream, 
with your choice of Blueberry or Strawberry Topping 

Ticket Price:  $50 per plate  

A reservation form with hotel information 
is located at the end of this Ledger.

 
AMERICAN LEGION FAMILY 

JOINT TESTIMONIAL 

FITZGERALD-CUMMINGS POST 2 

 7 Legion Drive,  Augusta, ME 04330 

May 7, 2022 
Social Hour 3-4 p.m. with appetizers 

Dinner: 4:00 p.m., Cash Bar  

MENU: Choice of Chicken Cordon Bleu or 
Baked Haddock. Both served with mashed 
potatoes, gravy, sweet peas, garden salad, 
dinner roll, and a dessert. Gluten Free meal 
option available (fish).  

Deadline for reservations: May 3rd, 2022 

$25.00 per person. Make checks payable to:  
American Legion Auxiliary Unit 2. Please write the 
number of chicken or fish dinners on check or 
enclose a note with the check. Write your name on the note. 

Gluten Free Option (fish) – Please state “GF” on 
check or enclose note with your name. All tickets to 
be picked up at the door. 

Mail to: American Legion Auxiliary Unit 2,  
Joyce Thurlow, 1 Meadowrue Drive, Augusta, 
ME 02330 

For more information CLICK HERE or go to: 

http://www.mainelegion.org/pages/news-events.php 

https://seadogs.formstack.com/forms/legion5_21
https://seadogs.formstack.com/forms/legion5_21
https://Abarker@seadogs.com/
http://www.mainelegion.org/pages/programs/dirigo-state.php
http://www.mainelegion.org/pages/programs/dirigo-state.php
http://mainelegion.org/
mailto:jason@mainelegion.org
http://www.mainelegion.org/pages/programs/dirigo-state.php
http://www.mainelegion.org/pages/news-events.php
http://www.mainelegion.org/pages/news-events.php
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100 MILES FOR HOPE  
CHALLENGE INFORMATION 
To:  All Legion Leadership 
From:  Dan Wheeler, National Adjutant 

I wanted to direct your attention to a new challenge 
as part of this year’s 100 Miles for Hope that allows 
members to support their departments while raising 
funds for the Veterans & Children Foundation.  
The national commander wanted to expand the 
Department Breakout Challenge for the entire  
duration of the 100 Miles for Hope challenge, which 
ends Sept. 5. 

Here’s how it works: 

• Proceeds from registrations and donations go 
directly to the V&CF. If you haven’t already  
registered, visit www.legion.org/100miles to  
register and learn more.  

• For the breakout challenge, departments are divided 
up into categories by size. You can find out which 
category your department is in by visiting the 
FAQ page here.  

• The department in each category that raises the 
most money for the V&CF via the 100 miles  
challenge will receive a plaque from the national 
commander. 

• To ensure that your fundraising gets credited to your 
department, you must join its team. There are two 
ways to join or support a department or team. 

1. Make a donation. To donate to your department, 
download this PDF to find your department. 
Then either click the link to go to your  
department donation page, or text your unique 
department code to 71777. After texting your 
department code, you will receive a link to  
donate to your department. 

2. Fundraise. Go to Mobile Cause to sign up and 
then choose “Become a fundraiser” then select 
a team. All of the departments have  
already been created. To join a team after initial 
set-up, log back into your Mobile Cause page 
or type in app.mobilecause.com/vf/100MFH/
YourName and select edit at the bottom of the 
page, then click Join a Team. 

Additionally, I wanted to share some resources with you 
to help promote this great program. Those include:  

Promotional materials. National headquarters staff 
has created promotional items for participants to 
share. For example, there is a poster that can be 
displayed at your post, community center or  
elsewhere. Additionally, there is a small handout 
card with a QR code that can be given to someone to 
sign up or donate on the spot, or used as a leave-
behind at a meeting. Visit legion.org/100miles/tools 
for these and other promotional items. 

Share your story. The American Legion encourages 
all participants to share their 100 Miles for Hope 
journey. A few ways to do this is by sharing your 
progress and fundraising achievements on the  
Legiontown web page. And for social media posts, 
use the hashtag #100MilesForHope. Tag The Ameri-
can Legion and staff will help share your progress.  

Facebook shares. An American Legion member has 
graciously volunteered to create personalized social 
media graphics that you can share on Facebook and 
other social media sites. All you need to do is send 
an email to her with a photo, and she will create one 
for you. Learn more at legion.org/100miles/share. 

Create your own team. It is also possible for  
American Legion districts, posts or other entities 
that would like to create their own challenge against 
another group. For example, two posts, districts, or 
Riders chapters could create their own challenge. If 
you would like to create a new team, please 
email donorservices@legion.org.  

Thank you for your support of this great program, 
and our Veterans & Children Foundation.  

Please direct questions to Henry Howard at  
magazine@legion.org.  Thank you. 

.

 

MILITARY TRIVIA 

  Why are US Marines called  
“leathernecks”?  

 

Q: 

http://www.legion.org/100miles
http://legion.org/100miles/faq
http://legion.org/100miles/faq
https://www.legion.org/sites/legion.org/files/legion/documents/100MFH%20Team_URLS%20%20.pdf
http://app.mobilecause.com/vf/100MFH
http://legion.org/100miles/tools
http://www.legiontown.org/
http://www.legiontown.org/
http://legion.org/100miles/share
mailto:donorservices@legion.org
mailto:magazine@legion.org
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COMMANDER’S PROJECT 
2021-2022 

American Legion, Department of Maine Foundation 

T he American Legion, Department of Maine 
Foundation is a 501(c)(3) non-profit organization 

exclusively for charitable purposes.  All donations to 
the foundation are tax deductible under the United 
States Tax Code and Internal Revenue Service. 

The Mission of the Foundation is to provide finan-
cial assistance, promote Americanism, Youth  
Programs, National Security, and Veterans Affairs 
and Rehabilitation that will enhance the lives of our  
veterans, their families, children and communities in 
the State of Maine today and for future generations. 

My goal this year is to raise $15,000 for the Endowment 
Fund to help fund American Legion Americanism 
Programs. Examples include Baseball, Dirigo (Boys) 
State, and the Oratorical Scholarship program. 

America’s future lies in our children. 

American Legion Baseball, founded in 1925, has 
taught hundreds of thousands of young Americans 
the importance of sportsmanship, good health and 
active citizenship. The program is also a promoter of 
equality, making teammates out of young athletes 
regardless of their income levels or social standings.  

At Dirigo (Boys) State, participants learn the rights, 
privileges and responsibilities of franchised citizens. 
The training centers on the structure of city, county and 
state governments. Students are elected to various 
offices. Activities include legislative sessions, court 
proceedings, law-enforcement presentations, assemblies, 
bands, and recreational programs. The two  
representatives elected to represent Maine at Boys 
Nation in Washington, of federal government. 

The American Legion Oratorical Contest exists to  
develop deeper knowledge and appreciation for the 
U.S. Constitution among high school students. Since 
1938, the program has presented participants with an  
academic speaking challenge that teaches important 
leadership qualities, the history of our nation’s laws, 
the ability to think and speak clearly, and an  
understanding of the duties, responsibilities, rights 
and privileges of American citizenship. 

All these programs help to train and shape our youth 
into outstanding citizens.  Many will become our  
future leaders and many may become leaders in the 
American Legion. 

I am asking all of you: Legionnaires, Legion Posts, 
and Districts to please contribute to this endowment 
fund.  It will help so many for many years to come. 

Any amount will help, but some have asked for  
specific amounts.   

This is my hope for suggested donations: 

Posts with Canteens:  $250  
Posts without Canteens: $100 
Districts:    $200 

Individuals: Whatever you believe you  can contribute. 

To donate online, please CLICK HERE, or visit 
http://www.mainelegion.org/pages/foundation/
donate.php; click on the “DONATE TODAY” 
button and choose Fund 001 AL DOM Foundation 
– Endowment Fund and choose Donate with a 
Debit or Credit Card.  

Checks should be made payable to American Legion 
Department of Maine Foundation and mailed to: 
American Legion Department of Maine Foundation, 
5 Verti Drive Winslow, Maine 04901-0727. Please 
make sure to provide your name and address so that 
we may send you a tax receipt.  

Thank you all. For God and Country.   

Commander Deb Couture 

 

 

Earth Day April 22 

Earth Day is an annual event  celebrated around the 
world on April 22 to demonstrate support for 
environmental protection. First celebrated in 1970, 
it now includes events in more than 193 countries. 

Earth Day was the brainchild of Sen. Gaylord Nelson  
of Wisconsin, a staunch environmentalist who hoped 
to provide unity to the grassroots environmental 
movement and increase ecological awareness. 

Nelson—whose efforts in Congress included legislation 
protecting the Appalachian Trail and banning 
DDT—hired Denis Hayes, a Harvard grad student. 
Together they organized the first Earth Day. 

Today, Earth Day is widely recognized as the largest 
secular observance in the world, marked by more 
than a billion people every year as a day of action. 

Many important environmental events have  
happened on Earth Day since 1970, including the 
signing of the Paris Agreement. 

The first Earth Day was focused on the United 
States. In 1990, Hayes, the original national 
coordinator in 1970, took it international and  
organized events in 141 nations. 

Thanks largely to the momentum created by Earth 
Day, the early 1970s saw the passage of the most 
important environmental legislation in US history, 
including both the Clean Air and Clean Water acts. 

~ Bing 

http://www.mainelegion.org/pages/foundation/donate.php
http://www.mainelegion.org/pages/foundation/donate.php
http://www.mainelegion.org/pages/foundation/donate.php
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://www.history.com/this-day-in-history/the-first-earth-day
https://www.history.com/this-day-in-history/the-first-earth-day
https://www.history.com/this-day-in-history/the-first-earth-day
https://www.history.com/this-day-in-history/the-first-earth-day
https://www.history.com/this-day-in-history/the-first-earth-day
https://www.britannica.com/topic/Earth-Day
https://www.britannica.com/topic/Earth-Day
https://www.britannica.com/topic/Earth-Day
https://www.britannica.com/topic/Earth-Day
https://www.britannica.com/topic/Earth-Day
https://www.earthday.org/history/
https://www.earthday.org/history/
https://www.earthday.org/history/
https://www.earthday.org/history/
https://www.earthday.org/earth-day-2021/
https://www.earthday.org/earth-day-2021/
https://www.earthday.org/earth-day-2021/
https://www.earthday.org/earth-day-2021/
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://en.wikipedia.org/wiki/Earth_Day
https://www.rollingstone.com/culture/culture-features/denis-hayes-interview-50th-anniversary-earth-day-987606/
https://www.rollingstone.com/culture/culture-features/denis-hayes-interview-50th-anniversary-earth-day-987606/
https://www.rollingstone.com/culture/culture-features/denis-hayes-interview-50th-anniversary-earth-day-987606/
https://www.rollingstone.com/culture/culture-features/denis-hayes-interview-50th-anniversary-earth-day-987606/
https://www.rollingstone.com/culture/culture-features/denis-hayes-interview-50th-anniversary-earth-day-987606/
https://www.bing.com/search?q=earth+day+2022&form=ANNH01&refig=9c1214d5da204a428042252de860a3d0
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 2022 AMERICAN  
LEGION BASEBALL   
“REACH OUT & 

FIND OUT” 

P lay ball! That’s the refrain we are waiting for as 
spring and baseball season approaches! 

American Legion Baseball will be starting very soon 
and now is the time for your post to come forward 
and fulfill their responsibility under the Fourth Pillar 
– Children and Youth.  

Full sponsorship of a Legion Baseball team is a  
costly endeavor and it is realized a lot of Maine 
Posts might not be able to fully sponsor a team. 
However, any post can reach out to their local team 
and offer support in differing ways. Any financial 
donation would be greatly appreciated, but, you can 
also assist them by offering to help with on field 
preparation work, maybe running a concession stand 
where proceeds might be split between the team and 
post or perhaps if your post is so equipped hold a 
fund raising spaghetti or baked bean dinner as these 
events are normally well attended for the benefit of 
youth sporting teams. 

If you are not sure if your local community has a 
team associated with American Legion baseball, no 
problem, call or email me and I will get you in touch 
with contacts for the local Legion Team.    

This is an opportunity that should not go unfulfilled 
by Maine American Legion posts. It cannot be easier 
just; REACH OUT locally to your team and FIND 
OUT what your post can do to help. Work to sup-
port our Fourth Pillar! 

Please contact me if you now support or want to 
support a Legion Baseball Team, you won’t regret 
getting involved. To reach me; Cell 691-2270; email 
jandc79@myfairpoint.net.  

Jeff Sukeforth, Maine American Legion Baseball Director 
691-2270   |    jandc79@myfairpoint.net 

For more information CLICK HERE  or go to: 
www.mainelegion.org/pages/programs/baseball.php 

 
 

 
 
 
 
 
 
 

AWARD NOMINATIONS DUE AT 
DEPT. HQ BY MAY 1ST 

I nterested in nominating someone for an American 
Legion Award to be presented at our 103rd  

Annual State Convention June 10-11, 2022?  

For example: 
• Law Officer OTY 

• EMT/Paramedic OTY 

• Firefighter OTY 

• Game Warden OTY 

• Humanitarian OTY 

• Legionnaire OTY, etc.   

Please submit applications  
to Department Headquarters  

No Later Than May 1st. Award 
applications can be obtained by 
visiting: 

http://www.mainelegion.org/pages/formsapplications.php  

or contact Department HQ at 873-3229  

 

Make Your Name Part of The 
American Legion History 

Become a Sponsor Today in  
Support of Maine Veterans! 

Deadline for Submission 
is May 6, 2022 

Become a sponsor of our Maine American Legion 
Convention yearbook as an “individual donor” and 
help support Veterans in the State of Maine.  As a  
contributor, your name (individual or business) will 
be listed in our 2022 Maine American  Legion 
yearbook and made available in print and online in 
digital format on www.mainelegion.org. 

Donations may be made by 
clicking on the DONATIONS 
WELCOMED button located 
on our Legion website at       
www.mainelegion.org  

and selecting “Donate with Debit or Credit Card”, or 
by check payable to The American Legion, Depart-
ment of Maine, 5 Verti Drive, Winslow. 

Show your support to our Veterans in the State of 
Maine! Become a sponsor today and make your 

name part of The American Legion History 

To purchase ad space, please submit payment along 
with Maine American Legion Convention Yearbook 
Sponsorship Request Form (see page 10 & 11) or 
visit www.mainelegion.org.      

Irving Oil 

Savings 

https://indd.adobe.com/view/9a3f816d-3838-4d55-99e3-c7a37f33ac0b
https://www.paypal.com/donate/?cmd=_s-xclick&hosted_button_id=WEKL5GPUELPMU&source=url
http://www.mainelegion.org/pages/programs/baseball.php
http://www.mainelegion.org/pages/programs/baseball.php
http://www.mainelegion.org/pages/formsapplications.php
http://mainelegion.org/
http://mainelegion.org/
http://mainelegion.org/
https://www.irvingoil.com/en-US/home-energy/home-energy-solutions
https://www.irvingoil.com/en-US/home-energy/home-energy-solutions
https://www.irvingoil.com/en-US/home-energy/home-energy-solutions
https://www.irvingenergy.com/
https://www.irvingenergy.com/
https://www.irvingenergy.com/
http://www.mainelegion.org/pages/programs/baseball.php
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The Department of Maine is Announcing 

the Dates for Maine Legion College 2022 

Legion College enhances knowledge and appreciation 
of The American Legion, classes teach the core  
values and contributions of the organization, its 
Auxiliary, Sons of The American Legion and other 
programs. Maine Legion College prepares Legion-
naires for leadership positions in posts, districts, 
committees, and departments through education,  
development, and motivation. The curriculum  
challenges student leaders to think critically and  
creatively about issues confronting the Legion. 

The 3-weekend commitment is open to Legion 
members, and if space permits we include Riders, 
Sons, and Auxiliary members. 

Phase 1: April 23-24 
Phase 2: July 23-24 

Phase 3: September 24-25 

To reserve your spot email: jason@mainelegion.org 

Call Now – Space is Limited! 

 

MEMBERSHIP IMPACT REPORTS 

The American Legion’s success depends entirely on 
active membership, participation and volunteerism. 
The following monthly reports located on: https://
www.legion.org/membership/impact provide a 
summary of membership, participation and 
volunteerism making an impact in the lives of veter-
ans, families and communities. American Legion 
Posts can share the many ways Legionnaires are 
making a difference in their communities by sub-
mitting consolidated post reports online. To visit 
the impact American Legion posts made throughout 
the year, visit: https://www.legion.org/
bythenumbers   or https://www.legion.org/
membership/impact. 

PAST COMMANDERS CLUB 

P lease note that the annual dues for Past  
Commanders Club have increased to $5.00/

member. See Page 9 for an application.  

 

 

April 

 4/6 Army Day/US Entered WWI (1917) 
 4/9 National Former POW Recognition Day 
 4/11 Desert Storm Cease-fire (Persian Gulf 

War)(1991) 
 4/12 Civil War Began (1861) 
 4/25 Spanish-American War Began (1898) 

 

 

American Legion Special Orders 
NEW LOGO AVAILABLE! 
 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 

MILITARY TRIVIA 

         The term “leatherneck” 
was derived from a leather 
stock once worn around the 
neck by both American and 
British Marines and soldiers. 
The dress blue uniform of the 
US Marines still bears a tribute to that stock collar 
today with a stiff cloth tab behind the front of its collar.  

mailto:specialorders@legion.org?subject=New%20Logo
http://em.legion.org/c/1kb7CqD4VI0ZEWzVPEDFQMba
http://em.legion.org/c/1kb7YUKFb6vZtyB0HBdt1Vhj
http://em.legion.org/c/1kb6wYgkbww0d6wHdOUijkSJ
mailto:jason@mainelegion.org
https://www.legion.org/membership/impact
https://www.legion.org/membership/impact
https://www.legion.org/membership/impact
http://www.mylegion.org/
http://www.mylegion.org/
https://www.legion.org/bythenumbers
https://www.legion.org/bythenumbers
https://www.legion.org/membership/impact
https://www.legion.org/membership/impact
http://www.mainelegion.org/pages/formsapplications.php
http://www.mainelegion.org/pages/formsapplications.php
https://en.wikipedia.org/wiki/United_States_in_World_War_I#:~:text=The%20American%20entry%20into%20World%20War%20I%20came,to%20get%20the%20United%20States%20into%20the%20war.
https://www.whitehouse.gov/briefing-room/presidential-actions/2021/04/09/a-proclamation-on-national-former-prisoner-of-war-recognition-day-2021/
https://www.chron.com/news/nation-world/article/April-11-marks-25th-anniversary-of-the-official-7237966.php
https://www.chron.com/news/nation-world/article/April-11-marks-25th-anniversary-of-the-official-7237966.php
https://www.history.com/this-day-in-history/12-766-video
https://american-history.net/19th-century-america/19th-century-wars-overview/1986-2/
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             COMPUTER 101 is a resource for those  

    who wish to learn basic skills with  
          the powerful technology of today’s 

world. Increased proficiency with computers is good 
both personally and professionally.  

Basic Tasks for Creating a Powerpoint Presentation 

PowerPoint presentations work like slide shows. To 
convey a message or a story, you break it down into 
slides. Think of each slide as a blank canvas for the 
pictures and words that help you tell your story. 

When you open PowerPoint, you’ll see some built-in 
themes and templates. A theme is a slide design that 
contains matching colors, fonts, and special effects 
like shadows, reflections, and more. 

1. On the File tab of the Ribbon, select New, and 
then choose a theme. PowerPoint shows you a 
preview of the theme, with four color variations 
to choose from on the right side. 

2. Click Create, or pick a color variation and then 
click Create. 

3. On the Home tab, click the bottom half of New 
Slide, and pick a slide layout. 

Save Your Presentation 
1. On the File tab, choose Save. 
2. Pick or browse to a folder. 
3. In the File name box, type a name for your 

presentation, and then choose Save. 

Add text 
Select a text placeholder and begin typing. 

Format Your Text 
1. Select the text. 
2. Under Drawing Tools, choose Format. Do one 

of the following: 
• To change the color of your text, choose Text 

Fill, and then choose a color. 
• To change the outline color of your text, 

choose Text Outline, and then choose a color. 
• To apply a shadow, reflection, glow, bevel, 3-D 

rotation, a transform, choose Text Effects, and 
then choose the effect you want. 

Add Pictures 
On the Insert tab, do one of the following: 

1. To insert a picture that is saved on your local 
drive or an internal server, choose Pictures, 
browse for the picture, and then choose Insert. 

2. To insert a picture from the web, choose Online 
Pictures, and use the search box to find a picture. 

3. Choose a picture, and then click Insert. 

Add Shapes 
You can add shapes to illustrate your slide.  
1. On the Insert tab, select Shapes, and then select a 

shape from the menu that appears. 
2. In the slide area, click and drag to draw the shape. 

Select the Format or Shape Format tab on the ribbon. 
Open the Shape Styles gallery to quickly add a color 
and style (including shading) to the selected shape. 

Add Speaker Notes 
Slides are best when you don’t cram in too much 
information. You can put helpful facts and notes in 
the speaker notes, and refer to them as you present. 
1. To open the notes pane, at the bottom of the  

window, click Notes. 
2. Click inside the Notes pane below the slide, and 

begin typing your notes. 

Save Your Presentation!!   

Next issue: How to set up 
your presentation for a slideshow 

~ Microsoft 

The American Legion  
Department of Maine 

General Fund 
Eugene & Shirley Bibber………...……… $40.00 

Betsy Ann Ross House Fund 
ALR Winthrop Chapter 4 ……………... $500.00 

Maine Blind Camp Fund 
Wiscasset Post 54…….……………...… $200.00 
Presque Isle Post 88…………………….. $100.00 
Caribou Post 15…………………………. $50.00 
Monson Post 116 ………………………. $100.00 
Skowhegan Post 16 …………………….. $50.00 
Richmond Post 132…………………….. $200.00 

Yearbook Fund 
District 12, Hancock County..………….. $50.00 

THE American Legion 
Department of Maine Foundation 

2022 Commanders Project – Couture 
Hermon Post 200……………………….. $100.00 

Brunswick Post 20 …………………….. $100.00 

Berwick Post 79………………………... $200.00 

District 12, Hancock County...…………... $50.00 

 

 

 “On the battlefield, the military pledges to  
leave no soldier behind. As a nation, let it be  

our pledge that when they return home,  
we leave no veteran behind.”  

~ Dan Lipinski  
 

“America is hope. It is compassion.  
It is excellence. It is valor.” 

~ Paul Tsongas 
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Y ou can find more information on the Tribute Wall at http://tributewall.org/. As we plan this very special 
weekend, we are reaching out to ask if you would be interested in contributing to the cost of bringing the 

Wall to Maine. The cost to bring the wall to Maine is estimated at $12,000. The memorial will be set up and 
on display at the Augusta Elks Lodge for 2 days and open to the public to view. Any funds raised will be used 
towards the cost of bringing the wall to Maine and associated expenses with the weekend activities and the wall. 
Any amount raised above the expenses for the weekend will be donated to veteran organizations. 

If you are considering donating, please  contact James Orr, Committee Chair at 207-480-0438 or 
Jeorr007@yahoo.com. 

** Donations can be mailed to Augusta Elks #964, P.O. Box 2206, Augusta, ME 04338-2206. 
Please make checks payable to Augusta Elks 964 and note c/o Tribute Wall in memo. ** 

http://tributewall.org/
mailto:Jeorr007@yahoo.com.
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This form may be filled out on-line at:  www.mainelegion.org/pages/formsapplications.php 

*** Please note that the annual dues for Past Commanders Club have increased to $5.00/member)*** 

http://www.mainelegion.org/pages/formsapplications.php
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Reservation Sheet 

 

Please Print All Information 

 

Contact Name:   

Phone:  Email: 

   

Dinner 

Number of Tickets:     at $50 each 

Total amount enclosed:  $  

Maine Lobster _______      Steak _________ 

Please make checks payable to: Donald Allisot.  
Mail checks and reservation sheet(s) to:  

Donald Allisot,  
P.O. Box 438, Woolwich, ME 04579 

RSVP by Friday, May 6th, 2022 

~ ~ ~ ~ ~ ~~  

Hotel Accommodations 

Best Western Plus Brunswick Bath 
71 Gurnet Road, Brunswick, ME 04011 (207) 725-5251.  

Use code “Sons of the American Legion”. Double occupancy Rooms and King rooms available 
Room rates:  $165/night (does not include tax) 

The Brunswick Hotel 
4 Noble Street, Brunswick, ME 04011 (207) 837-6565.  

Use code “Sons of the American Legion” Double occupancy rooms available.  
Room rates:  $269/night (does not include taxes and facility fee) 

 

Other Hotel Accommodations in the Area 

Days Inn by Wyndham Brunswick 
224 Bath Road, Brunswick, ME 04011 (207) 725 – 8883 

Comfort Inn Brunswick 
199 Pleasant Street, Brunswick, ME 04011 (207) 729-1129 

Residence Inn by Marriott 
139 Richardson Street, Bath, ME 04530 (207) 443-9741 

Hampton Inn Bath 
140 Commercial Street, Bath, ME 04530 (207) 386-1310 

  


